
CHAPTER 3

Developing a Targeted 
Promotional Campaign
Course: Principles of Marketing

This chapter involves implementing a market segmentation program. You will plan 
the promotional campaign for Outdoor Living Inc.’s* new recreational product in 
the Florida market. The firm makes camping and recreational equipment and has 
introduced a new, moderately priced camper to attract middle-income families 
who are new to camping. To be successful, the firm must reach concentrations of 
targeted customers with its promotional campaign for the new product. You will 
learn how to use GIS tools to achieve this goal with each of the three components 
of this campaign: advertising, direct mail, and outdoor shows sponsored by 
recreational stores.

* This is a fictional company and scenario, created for educational purposes only. Any 
resemblance to actual persons, events, or corporations is unintended.
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Learning objectives

To maximize the effectiveness of the promotional campaign in Florida, you will learn how to use 
ArcGIS to:

Create map symbology to display population demographics
Select target Florida families for advertising and direct-mail components of a promotional 
campaign using appropriate geographic units and demographic attributes
Select Tampa-area recreational stores with outdoor shows based on their location relative to 
target market households
Design maps to communicate and support your recommendations

Marketing scenario

Outdoor Living Inc. manufactures a wide range of products for recreational outdoor living. The 
product line ranges from small, one-person tents for backpackers to large tents for camping and 
enclosed awnings for large gatherings.

The firm’s newest product, the Conestoga, is a modular camper tent mounted on a small trailer for 
towing behind a vehicle. In addition to the pop-up tent commonly offered with competing products, 
it includes a modular enclosed “porch” that extends the unit with a covered space large enough for 
dining or recreation. In addition, the basic unit incorporates a patented compact kitchen unit that 
provides electricity, cooking, and washing facilities. The Conestoga also contains an integrated 
entertainment center with satellite television, DVD, and advanced audio capabilities. The unit is 
exceptionally light, easily maintained, and simple to set up and take down. It is designed to make 
outdoor living quick, comfortable, and easy for families with children.

The features and convenience of the Conestoga make it ideal for a family new to camping. In 
addition, innovative design and production techniques allow Outdoor Living to offer the model at 
an attractive price point. Therefore, Outdoor Living plans to focus its marketing efforts on families 
in a middle-income range in hopes of attracting them to the recreational pleasures of camping. 
Ideally, they will be satisfied with their experience and become lifelong campers and consumers of 
Outdoor Living products.

For these reasons, Outdoor Living has chosen to supplement its national advertising campaign with 
more focused efforts to reach new consumers in its target market. Specifically, the firm plans to:  
(1) conduct local television and newspaper advertising in markets with high concentrations of target 
customers; (2) reach targeted consumers via direct mail with price incentives; and (3) demonstrate 
the benefits of the new product in outdoor shows at outlets serving its targeted consumers.

Within this strategy the key to success is identifying concentrations of prospects who fit the profile 
of the product’s target segment: families with incomes of $35,000 to $60,000. As sales manager 
for the southeastern U.S. region, your tasks are to identify geographic concentrations of target 
customers and design your promotional activities to reach them efficiently. You have chosen to begin 
this process with the state of Florida and have acquired data on population, family size, income, and 
market segmentation measures for the state.

1.
2.

3.

4.
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Background information

Market segmentation is one of the most powerful tools in the marketing field. It allows firms to 
identify specific groups of consumers based on their common characteristics and design marketing 
offerings custom tailored to their needs and preferences. Successful use of segmentation tools allows 
marketers to enhance brand image, build customer loyalty, and decrease price sensitivity, all of 
which contribute to long-term sales and profits.

Market segments are defined using a wide range of segmenting dimensions including demographic, 
socioeconomic, lifestyle, benefit, and usage measures. The choice of segmenting dimensions 
depends upon several factors, including competitive conditions in the product market, the 
availability and cost of relevant data, and the market position of the firm’s brand.

However segments are defined and analyzed, for segmentation strategies to be successful, marketers 
must be able to effectively reach targeted consumers with promotion, products, and services. In 
most cases, this requirement implies a spatial dimension to the implementation of a segmentation 
strategy. To reach customers, marketers must know where they are. Further, different distribution 
and promotional approaches require that marketers analyze customer location in different ways. 
This chapter illustrates that concept.

Outdoor Living has defined its target market as families with incomes between $35,000 and 
$60,000. Though this appears to be a straightforward definition, it does include judgments about 
buying behavior for the Conestoga. As a demographic variable, families is one of several measures 
of population units, and refers to people who reside together and are related to each other by 
birth, marriage, or adoption. Population, another measure, is defined as the total number of people 
residing in a geographic area, whatever their living arrangement. Households include people who 
are residing together whether or not they are related to each other. Thus, families are included 
in households, but not all households are families. You may get more information about families 
from the dataset by comparing the total family population measure with the total population 
measure. The ratio of these two measures is the total percentage of the population living in family 
units. Outdoor Living’s focus on families reflects the judgment that family units, not individuals or 
households of unrelated people, will be the purchasing unit for the Conestoga product.

The income dimension of Outdoor Living’s target segment reflects the firm’s perception of the 
general income boundary between the categories in its product mix. Families with lower levels of 
income will be more attracted to Outdoor Living’s tent products, while those with higher levels will 
be more attracted to motorized recreational vehicles. Remember that these boundaries are not fixed, 
but represent behavioral tendencies among target consumers.

This combination of measures is captured in two variables in the dataset: number of families in 
the target market (the total number of families in the designated income range) and percentage of 
families in the target market (the number of target market families as a percentage of all families 
in a geographic area). Each of these measures is useful in the process of planning Outdoor Living’s 
promotional campaign.

In this planning process, you will also use several different geographic units. Each represents 
a different approach for dividing larger geographic units into smaller ones for purposes of 
understanding the distribution of a population characteristic. You will begin the process with 
political units of geography—the state of Florida and its counties.

Another type of unit is the ZIP Code system that the U.S. Postal Service uses to facilitate mail 
delivery. As ZIP Code boundaries can change over time, postal geographies are not as valuable for 
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longitudinal research as are census geographies (described below), which, though not permanent, 
are relatively more stable. However, from a marketing perspective, ZIP Code level analysis is useful 
because it is actionable. That is, attractive ZIP Codes are more easily targeted with direct-mail tools 
than are units of census geography.

Census geography units are created by the U.S. Census Bureau to administer and report its 
decennial census of the country. The most basic units of census geography for which data is 
reported are:

Census tracts, which are subdivisions of counties

Census block groups, which are subdivisions of census tracts

Census blocks, which are subdivisions of census block groups

Census tracts were originally drawn to reflect some degree of internal demographic similarity, 
though this has often been eroded by natural patterns of population migration. They also vary in 
size, though the average census tract population is about 4,000. However, because census tract 
boundaries remain relatively stable over time, this unit is useful for tracking long-term change in 
population patterns. The census tract is the unit of census geography included in Outdoor Living’s 
promotional planning analysis.

The Census Bureau and commercial marketing data suppliers also use several other geographic 
units to report population characteristics. Core Based Statistical Areas are population centers 
with integrated economic, transportation, and communication systems that often cross county or 
even state boundaries. They include Metropolitan Statistical Areas (larger urban and suburban 
areas surrounding a city of 50,000 or more, or a general urban area of 100,000 or more) and 
Micropolitan Statistical Areas (urban and suburban areas around a population center of 10,000 to 
50,000). Some commercial marketing data firms also collect and report data for a geographic unit 
that they themselves define. Nielsen Media Research’s Designated Market Areas is an example of 
this type of geographic unit.

Outdoor Living Florida data dictionary
Attribute Description 

For State, Counties, ZIPCodes and HillsboroughCensusTracts

TOTPOP_CY Total population, 2004

FAMPOP_CY Family population, 2004

FAMHH_CY Family households, 2004

AVGFMSZ_CY Average family size, 2004

PCI_CY Per capita income, 2004

NumFamInTM Number of families in target market, 2004

PctFamInTM Percentage of families in target market, 2004

For MajorCities

AreaName City name

Capital State capital (yes or no)

For OutdoorStoresShows

StoreName Name of outdoor store

Source: ESRI Community Data, 2005

•

•

•



Explore demographic characteristics  Exercise 3.1 51

Exercise 3.1 Explore demographic 
characteristics
To maximize the effectiveness of your promotional campaign, you must focus your resources on 
geographic concentrations of your target customers. To prepare for this analysis, you must explore 
demographic variations among Florida’s geographic areas. Thus, in this exercise, you will:

Load, display, and explore maps of Florida

View thematic maps of Florida’s counties and their demographic characteristics

Examine data distribution in densely populated areas

Open an existing map
1 From the Windows taskbar, click Start > All Programs > ArcGIS > ArcMap.

Depending on how the software has been installed or which Windows operating system you are 
using, there may be a slightly different navigation menu from which to open ArcMap.

2 If you see a Start dialog box, click the “An existing map” option. Otherwise, click the Open button 
on the Standard toolbar.

3 Browse to the location of the GISMKT folder (e.g., C:\ESRIPress\GISMKT), double-click the 
OutdoorLivingFL folder, then click the OutdoorLivingFL1 map document and click Open.

When the map opens, several layers appear in the table of contents and a map of Florida appears 
in the map display area. The visible layers represent the state of Florida and its major cities. The 
Total Population by County, Average Family Size by County, and Per Capita Income by County 
layers represent demographic information about Florida’s counties, but are not currently visible. The 
Tampa Area Per Capita Income layer contains income data by census tract in the Tampa area, and is 
also currently not visible.

•

•

•
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Display map layers
The table of contents contains several items, called layers, each of which represents features that can be 
displayed on the map. You can view the layers by turning them on and off (clicking their check boxes).

Change the display order of layers

In ArcMap, layers draw from the bottom of the table of contents up. Thus, the top layer can obscure 
layers underneath it. The State of Florida layer is at the top of the table of contents thereby covering 
all the other layers. So even though the Cities layer is turned on, you can’t see the city markers 
because the state polygon is covering them. You can reorder layers in the table of contents by 
dragging them from one position to another.

1 In the table of contents, click Major Cities and hold down the mouse button.

2 Drag Major Cities to the top of the table of contents, then release the mouse button.

The symbols for the Major Cities layer now appear on top of the State layer.

Turn layers on and off

1 Turn off the State layer.

2 Turn on the Total Population by County layer.

In general, what parts of the state contain the highest population measures?

3 Now turn on the Major Cities and Per Capita Income by County layers and turn all other layers off.
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Explore demographic characteristics with 
thematic layers
Thematic layers allow you to display selected attributes of features in a map format. They are useful 
in analyzing and communicating the distribution of demographic characteristics within a region 
of interest. In this task, you will explore the variations of population, household size, and income 
among Florida’s counties. To do so, you will turn the various county data layers on and off, allowing 
you to review the distribution of population, household size, and income.

Identify data for specific counties

You may use the Identify tool to click on a feature, like a county, and display its attribute 
information.

1 From the Tools toolbar, click the Identify tool.

2 Click inside the county southwest of Miami.

This county flashes briefly and the Identify window displays all the attributes for this county, 
Monroe County. You may use this tool to review the attributes of any other counties you wish. 
Consult the data dictionary to determine the meaning of attribute names.

3 Close the Identify window.

4 Turn off the Per Capita Income by Country layer, and turn on the Average Family Size by  
County layer. Observe the data distribution of this layer. When you’re finished, turn on the Total 
Population by County layer.
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Change the data represented by a layer

The Total Population by County layer displays the number of people in each county. However, 
Outdoor Living’s target market is defined as families. Therefore, the number of family households 
in an area is a more relevant market measure than is total population. Thus, you must revise the 
Total Population by County layer to display this attribute.

1 Double-click the Total Population by County layer (or right-click the layer and select Properties).

2 Click the General tab. For Layer Name, enter Family Households by County. Don’t click OK—that 
will close the Layer Properties dialog box, and you have more properties to change.

3 Click the Symbology tab. In the Value field, select the appropriate attribute. (Use the data 
dictionary to identify the attribute name for the Family Households measure.)
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4 Click OK.

5 In the table of contents, click the word FAMHH_CY under the layer name, then click again to make 
it editable. Replace FAMHH_CY with Families. (Note: If your second click is too quick, the Layer 
Properties dialog box will open. Click Cancel, then try again, clicking more slowly to reach the 
edit function.)

The resulting map displays the number of family households in each of Florida’s counties. This data 
is more directly related to the firm’s target market than total population.
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Display data distribution in smaller areas

You have observed attribute variation between Florida’s counties. With ArcMap you may also 
explore variations within smaller geographic areas. Consider the Tampa region as an example.

1 Click the check boxes to the left of the layers in the table of contents to display only the Major 
Cities, Tampa Area Per Capita Income, and Per Capita Income by County layers. (Turn all other 
layers off.)

2 Right-click the Tampa Area Per Capita Income layer and click Zoom To Layer to zoom in and 
center the map display on the Tampa area.
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3 Turn off the Tampa Area Per Capita Income layer.

Compare this view with the previous view. This view indicates that the counties within the Tampa 
region fall within the middle income classification. However, the previous view reveals that many 
of the census tracts in the area fall into the upper and lower classifications. Further, some census 
tracts in the region have levels of per capita income that are significantly lower than any of Florida’s 
counties, while other census tracts have levels that are significantly higher. Exploring these relation-
ships allows you to understand the distribution of Outdoor Living’s target market not only between 
counties but between the census tracts of a metropolitan area.

Update report and save map document
1 Use your observations of the maps you have displayed to answer the question below. Summarize 

your answer in the appropriate section of the project report template (OutdoorLivingFL_
ReportTemplate.doc) which you will find in your \GISMKT\OutdoorLivingFL folder.

What do you observe about the geographic distribution of family households, family size, 
and income in Florida’s counties?

2 Save your map file as OutdoorLivingFL1_fl.mxd (replace f and l with your first and last initials). 
To do so, from the File menu, choose Save As. Navigate to your \GISMKT\OutdoorLivingFL folder, 
type OutdoorLivingFL1_fl.mxd as the file name, and click Save.
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Exercise 3.2 Select counties for local 
advertising campaign
Local advertising media such as newspapers, radio, and television stations provide broad coverage 
of their local markets. Media costs are for insertions or time slots. While costs vary with audience 
size, they are not determined directly on a per-household basis, as direct-mail costs are. For these 
reasons, counties are the appropriate geographic units for the local advertising campaign and the 
number of target market families in each is the appropriate market measure. The budget for the 
local advertising campaign will support ten county markets. You will select the specific counties for 
the campaign based on the total number of families in the target market residing in each county. 
Thus, in this exercise, you will:

Identify the ten Florida counties with the largest number of families in the target market

Design a map that identifies these counties and their location

Calculate the total number of target market families that will be exposed to the campaign in 
these counties

Open an existing map
1 In ArcMap, open the OutdoorLivingFL2 map document found in your \GISMKT\OutdoorLivingFL 

folder.

The map contains two layers: an outline of Florida and its major cities.

•

•
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Add and display a new map layer
This analysis requires a map layer depicting the distribution of Outdoor Living’s target market 
across Florida’s counties. Recall that the target market is families with annual incomes between 
$35,000 and $60,000. Your first step is to add and display this map layer.

Add a map layer

1 Click the Add Data button. 

2 In the Add Data dialog box, navigate to the OutdoorLivingFL geodatabase found in your \GISMKT\
OutdoorLivingFL folder.

3 Double-click the geodatabase to open it. Click Counties.

4 Click Add to add the Counties feature class as a new layer to the map.

The resulting map displays Florida’s counties; however, every county is the same color. You will 
change the layer’s symbology so that each county’s color represents the correct attribute value.
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Edit a map layer’s symbology

1 Double-click the Counties layer in the table of contents (or right-click the layer and select 
Properties).

2 Click the General tab and enter Number of Families in Target Market as the new layer name.

3 Click the Symbology tab. In the Show area, click Quantities, then click Graduated colors.

4 Select the appropriate attribute name in the drop-down box in the Value field. (You can use 
the data dictionary to identify the attribute name for the number of families in target market 
measure.)

5 Click the “Show class ranges using feature values” check box to define classification ranges 
using actual values from the layer’s attribute table.
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6 Select any color scheme using the drop-down box in the Color Ramp field.

These settings specify which attribute value will be used to display the layer and how it will be 
displayed. Next you will designate how many classes will be used to display the data.

7 While still in the Layer Properties dialog box (on the Symbology tab), click the Classify button to 
display the Classification dialog box.

8 For the Method option, click the drop-down arrow and choose Quantile.

9 For the Classes option, choose 4.
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With these settings, you have specified that this layer will display in 4 classes, each containing 
a roughly equal number of counties. Note in the Classification Statistics area that Florida has 
67 counties. So 16 or 17 counties will be in each of the 4 classes.

The highest class will be composed of the top 10 counties that will be included in the initial 
promotional campaign, as well as another 6 or 7 counties to include in the campaign should 
additional funds become available.

10 Click OK to assign the 4 classes. Click OK again to complete the layer symbolization process.

The resulting map displays the distribution of Outdoor Living’s target market across Florida 
counties.

The class of counties with the highest values contains the 10 counties you are seeking in this task. 
You will now identify them specifically.
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Analyze data in attribute tables
You can view a layer’s data by opening its attribute table. You will sort, select, and calculate summary 
statistics on attributes in the counties layer table to learn the names of the top ten counties.

Sort and select counties based on attribute values

Your first task is to identify the ten Florida counties with the highest number of families in Outdoor 
Living’s target market. You will do so by sorting and selecting records in the layer’s attribute table.

1 In the table of contents, right-click the Number of Families in Target Market layer, and click Open 
Attribute Table.

The attribute table contains the data for each county feature in the layer.

2 Scroll horizontally through the table to find the NumFamInTM attribute, then right-click the 
column header cell and select the Sort Descending option.

This sorts the feature values for this attribute from highest to lowest. 

3 Click the small gray box to the immediate left of the first record in the table to select it.

This record turns blue to indicate that it is selected. If you look on the map, you will see that the 
corresponding county polygon is also selected and drawn in blue. You may need to move the 
attribute table to see the table and map simultaneously.

4 In the same manner, select several records in the attribute table and then view the changes on 
the map.

5 To select multiple features, click the small gray box to the immediate left of the topmost feature 
and hold your mouse button down. Move the mouse pointer down the column of boxes to select 
the first ten features in the table. Alternatively, you can press and hold the Ctrl key as you click 
each record.
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Note that the counties are selected simultaneously on the map as well. These counties will be the 
target of your advertising campaign.
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Calculate summary statistics for attributes

The final step in this exercise is to calculate the number of target market families that will be 
exposed to the advertising campaign. You will perform this step by calculating summary statistics 
for the relevant attribute in the attribute table.

1 Again find the NumFamInTM attribute, right-click the attribute name at the top of the column, 
then select Statistics. (Note: The top ten features for this attribute should still be selected in 
this table. If they are not, repeat step 5 above to select them. The summary statistics are only 
calculated for the selected records/features.)

In the Selection Statistics of Counties window, the Sum reports the total number of target market 
families in the ten selected counties. This is the number of families that will be exposed to Outdoor 
Living’s advertising campaign.

Update report and save map document
1 Use your map, attribute tables, and calculations to answer the questions below. Summarize 

your answers in the appropriate section of the project report template (OutdoorLivingFL_
ReportTemplate.doc) which you will find in your \GISMKT\OutdoorLivingFL folder.

Which ten counties should be included in Outdoor Living’s local advertising campaign? 
Why? How many target-market families will be reached by this campaign?

2 Close the statistics window and attribute table, and save your map file as OutdoorLivingFL2_fl.mxd 
(replace f and l with your first and last initials) in your \GISMKT\OutdoorLivingFL folder.
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Exercise 3.3 Select ZIP Codes for direct-
mail campaign
Direct mail offers customized communication with individual households that can easily be 
targeted by ZIP Code. Costs are based on the number of mailings and response rates are typically 
low. Thus, it is important that the highest possible percentage of recipients be target prospects. For 
these reasons, ZIP Codes are the appropriate geographic unit for the local advertising campaign, 
and the percentage of target market families is the appropriate market measure. The direct-mail 
budget for Florida will support a mailing to 750,000 households. You will select the ZIP Codes to 
be included in the mailing on the basis of the percentage of families in each that are in the target 
market. Thus, in this exercise, you will:

Identify the ZIP Codes in Florida with the largest percentage of families in the target market

Design a map that identifies these ZIP Codes and their location

Calculate the total number of ZIP Codes and family households that will be included in the 
mailing

Calculate the number of target market families who will receive mailings

Open an existing map
1 In ArcMap, open the OutdoorLivingFL3 map document found in your \GISMKT\OutdoorLivingFL 

folder.

This map document contains three layers: a basemap of Florida, Florida’s major cities, and ZIP 
Codes. The blank areas are national and state parks that are not assigned ZIP Codes.

•

•

•

•

EX
ER

C
IS

E 
3

.3



Select ZIP Codes for direct-mail campaign  Exercise 3.3 67

Edit a layer’s symbology
This map displays a ZIP Code layer, but it does not represent any data. You will edit this layer to 
display the percentage of families in each county that is in Outdoor Living’s target market.

1 Double-click the ZIPCodes layer in the table of contents (or right-click the layer and select 
Properties).

2 Click the General tab and enter Percent of Families in Target Market as the new layer name.

3 Click the Symbology tab. In the Show area, click Quantities, then click Graduated colors.

4 Select the appropriate attribute name in the drop-down box in the Value field. (You may use the 
data dictionary to identify the attribute name for the percentage of families in target market 
measure.)

5 Select a color scheme using the drop-down box in the Color Ramp field.

6 Click the “Show class ranges using feature values” check box to define classification ranges 
using actual values from the layer’s attribute table.

These settings specify which attributes will be displayed in this layer and how the layer will appear.
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7 In the Symbology dialog box, click the Classify button to display the Classification dialog box.

8 For Method, choose Quantile.

9 For Classes, maintain the default value of 5.

These settings determine how many data classes will be displayed and how they will be determined. 
You have specified that the data will be displayed in quantiles. This means that each classification 
group will contain approximately one fifth of Florida’s ZIP Codes. The group with the highest 
range of values for the attribute is the top 20 percent of ZIP Codes, the next group is the 20 percent 
of ZIP Codes with the next highest range of values, and so on through the classification groups.
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10 Click OK to return to the Symbology tab.

Note that the values for the class breaks are displayed as decimals with six decimal places. As these 
values are percentages, they should be displayed as such in the table of contents. You will specify 
these settings in the following steps.

11 Click the Label column header and then click Format Labels from the resulting menu to reach the 
Number Format dialog box. (Note: This is NOT the Labels tab in the Layer Properties dialog box, 
which serves a different function. If you clicked the Labels tab in error, click the Symbology tab 
and repeat the instruction above.)

12 Under Categories, click Percentage, and click the option “The number represents a fraction. 
Adjust it to show a percentage.”



CHAPTER 3  Developing a Targeted Promotional Campaign70

13 Click the Numeric Options button and, in the resulting dialog box, reduce the number of decimal 
places to 1.

14 Click OK in each of the three dialog boxes to accept the changes.

The resulting layer displays the percentage of target market families in each of Florida’s ZIP Codes. 
The map indicates which ZIP Codes have the highest concentration of target market families. You 
must now determine which of these ZIP Codes will be included in your 750,000-household mailing.

Analyze data in attribute tables
ArcMap allows you to analyze the data that underlies a layer by manipulating the layer’s attribute 
table. You will use the attribute table tools to sort, select, and calculate summary statistics for this data.

Sort and select counties based on attribute values

As in the previous task, you will sort and select records in a layer attribute table to identify those you 
will target. However, as the number of ZIP Codes is so much greater, you will perform this selection 
by using an attribute query rather than selecting records manually.

1 In the table of contents, right-click the Percent of Families in Target Market layer, then select 
Open Attribute Table.

This layer’s attribute table contains ZIP Code data for each of the features.

2 Scroll through the table to find the PctFamInTM attribute, right-click the column header, then 
select the Sort Descending option.
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The records are sorted from highest to lowest.

To maximize the effectiveness of your direct-mail campaign, your 750,000 mailings should be sent 
to the ZIP Codes with the highest percentages of target market families. Therefore, you should 
select ZIP Codes from the top of this list down until you reach a total of 750,000 households. You 
will use the Select by Attributes function to accomplish this task.

3 At the bottom of the attribute table, click the Options button, then choose the Select by Attributes 
option. (Note: You may need to increase the size of the attribute table to see the Options button.)

4 In the resulting Select by Attributes dialog box, double-click the attribute name [PctFamInTM], 
then click the >= operator, then type .316 at the end of the equation in the Query box so that the 
full equation reads: [PctFamInTM] >= .316 (This is the minimum value of the highest quantile in 
the classification scheme.)
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5 Click Apply, then click Close.

Records in the attribute table turn blue to indicate they are selected. The corresponding ZIP Codes 
are also highlighted in blue on the map.

You must now determine the number of ZIP Codes and family households that are contained in the 
selected ZIP Codes.

6 Find the FAMHH_CY attribute, right-click the column header, then select the Statistics option to 
display the Selection Statistics of ZIPCodes window.

In this window, the number of ZIP Codes selected is displayed as the Count while the number of 
family households in these ZIP Codes is displayed as the Sum.

How many ZIP Codes are selected? How many family households will receive the mailing?  
Look at the sorted attribute table. Can the next highest ZIP Code be added to the selection 
without exceeding the 750,000-household limit?

You have determined how many family households will receive mailings in this campaign. You must 
now determine how many of these households fall within Outdoor Living’s target market. To do so, 
you will repeat the Statistics calculation for the NumFamInTM attribute.

7 Close the Statistics window. Find the NumFamInTM attribute, right-click the column header, then 
click Statistics to display the statistics of this attribute.

In this window, the number of target market family households is displayed as the Sum.
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Update report and save map document
1 Use your map, attribute tables, and calculations to answer the questions below. Summarize your 

answers in the appropriate section of the project report template.

How many ZIP Codes and family households will be included in Outdoor Living’s 
direct-mail campaign? Why? How many target-market families will be reached by this 
campaign?

2 Save the map document as OutdoorLivingFL3_fl.mxd (replace f and l with your first and last 
initials) in your \GISMKT\OutdoorLivingFL folder.
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Exercise 3.4 Select stores for outdoor 
show demonstrations
Outdoor Living plans to feature its new product in outdoor and recreation shows in the major 
metropolitan areas of Florida. The budget will support four shows in the Hillsborough County 
portion of the Tampa area, and you will select the stores that will host the shows. Thus, in this 
exercise, you will:

Examine the distribution of target market families in Hillsborough County 

Identify retail outlets that sponsor outdoor shows each year

Select four stores for product demonstrations at outdoor stores

Open an existing map
1 In ArcMap, open the OutdoorLivingFL4 map document from your \GISMKT\OutdoorLivingFL folder.

This map document contains four layers, including a thematic layer that represents the number of 
families in the target market for each Hillsborough County census tract, and a layer that represents 
the location of recreational stores that sponsor outdoor shows. A layer depicting two-mile rings 
around these stores is not turned on. There is also a state layer for Florida.

•

•

•
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Explore stores and their surrounding areas
Note that the map displays the number of target market families in each of the area’s census 
tracts. Review the distribution across this metropolitan area. The map also displays retail stores 
that sponsor outdoor shows where the new Conestoga model might be displayed. You can use the 
Identify tool to learn more about the locations of the stores.

1 Click the Identify tool then click on one of the stores to display its attribute information in the 
Identify window.

2 Look at the attributes of other stores. As you move from store to store, observe the colors of the 
census tracts surrounding them to determine the number of target market families living near 
each store.

3 Close the Identify window when you’re finished exploring.
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Select specific stores for product 
demonstration at outdoor shows
Data from past outdoor shows suggests that most prospective buyers live within two miles of the 
show site. For this reason, you wish to view the areas where each outdoor show might draw these 
prospects.

1 Turn on the Outdoor Show Attraction Rings layer.

The resulting map displays a buffer ring with a two-mile radius around each outdoor show site.

2 Visually identify four stores that serve substantial numbers of target market families and are 
distributed across the Tampa area. Look for rings that contain several census tracts with high 
numbers of target market families and are geographically dispersed from each other. Your 
objective is to provide potential customers across the area an opportunity to view the Conestoga 
at a convenient outdoor show.

You will now use the map to display your selection.
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3 In the table of contents, right-click the Stores with Outdoor Shows layer, then click Selection > 
Make This The Only Selectable Layer.

4 Click the Select Features tool then click on a store of your choice. Notice that your selection 
is highlighted on the map.

5 Repeat this process with another store. When you select a second store, note what happens to 
the first store.

You will now use the multiple selection procedure to display the four stores you have selected for 
your outdoor store demonstrations.

6 With the Select Features tool active, click your first store again. Press the Shift key and hold it 
down. With the Shift key depressed, click your second chosen store.

7 Repeat this procedure to display your third and fourth selections.

The four selected stores are highlighted on the map. (Note: Although your map should be similar to 
that shown below, you may have made some different choices, which is OK.)

You will now export this map image and integrate it into the report template.
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Export map and insert into your report
1 From the main menu bar, click File > Export Map to reach the Export Map dialog box. Navigate to 

your \GISMKT\OutdoorLivingFL folder. For File name, type SelectedStores.emf, then click Save to 
save the map document as a graphic file in EMF format to include in your report.

2 Locate the instructional text in brackets in the fourth section of the project report template 
for this chapter. Select this text, then from the main menu bar in Microsoft Word, click 
Insert > Picture > From File. Navigate to your \GISMKT\OutdoorLivingFL folder and select the 
SelectedStores.emf file. Click Insert to insert the picture into the report as exhibit 1. (Note: You 
may have to select and resize the image to fit the space provided.)

Update report and save map document
1 Use ArcMap tools and your map to answer the following questions. Summarize your answers in 

the appropriate section of the project report template.

Which four stores in this area have you selected to host outdoor show demonstrations?  
Why do you think this combination will be effective in attracting targeted customers?

2 Save the map document as OutdoorLivingFL4_fl.mxd (replace f and l with your first and last 
initials) in your \GISMKT\OutdoorLivingFL folder.
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Exercise 3.5 Communicate and support 
your recommendations
You have completed the three components of your analysis and described your conclusions in the 
report template. You will now complete the report by summarizing your recommendations and 
providing maps to illustrate them. In this exercise you will: 

Restate your recommendations briefly

Explain how geographic targeting will increase the effectiveness of each of the three 
components of your local marketing campaign in Florida

Design two map layouts to support your analysis

Open an existing map
1 In ArcMap, open the OutdoorLivingFL5 map document from your \GISMKT\OutdoorLivingFL folder.

This map contains four layers: a basemap of Florida, a layer displaying the state’s major cities, a 
thematic layer displaying the number of families in the target market by county, and a thematic 
layer displaying the percentage of families in the target market by ZIP Code. The percentage layer 
is not turned on. This is the same map you created in exercise 3.2, and it identifies the ten counties 
you selected in that exercise as the focus of the advertising campaign.

•
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Create and edit a layout
In the first four exercises of this chapter, you used ArcMap as an analysis tool. In this exercise, you 
will use it as a communication tool by designing a map layout to support your report findings. A 
map layout is a collection of layers and other elements, such as legends, north arrows, scale bars, and 
text. You will use the ArcMap layout view to design a printable map, which you will use to increase 
the communication effectiveness of your entire marketing report.

1  From the main menu bar, click View > Layout View.

The map now appears in layout view with several additional elements added. Notice that the layout 
is a virtual piece of paper where you place and arrange elements to create a printable map suitable for 
a report, paper, article, or other presentation material.

Data frame

Title

Legend

North arrow

Scale bar

Text box
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2 Review the various layout elements and note how they contribute to its communication value. To 
zoom in for a closer look, use the Zoom In tool on the Layout toolbar, which should have appeared 
when you switched to layout view. Although the tools on the Layout toolbar are similar to the 
navigation tools on the Tools toolbar, they are somewhat different, so familiarize yourself with 
each one.

The actual map illustrates the data frame, which includes all the layers you have been working with. 
A legend, north arrow, and scale bar all convey the meaning, orientation, and scale of the map to 
the reader. The three text boxes at the bottom contain data source information, the meaning of the 
selected features, the author, and creation date of the map—information readers require to evaluate 
the credibility of the map.

All the elements depict information about Florida’s counties relative to the advertising campaign 
decision. However, the author and creation date information is incomplete. You must supply this 
information to complete your map for exhibit 2 in the report.

3 Notice the small text box at the bottom of the page that includes the Submitted by and Date 
elements. With the Select Elements tool click the text to select it. (A blue dashed line will appear 
around the text to show it has been selected.)

4 Right-click the selected text box and choose Properties.

5 In the Properties dialog box, replace [Your Name Here] with your name, and replace [Today’s 
Date] with the correct date. Click OK to accept the changes and close the dialog box.

Readers of your report must be able to ascertain the source and currency of the information it 
displays. You will edit the sources text box to provide this information.

6 Click the Sources text box just below the map, then right-click it and choose Properties. Replace 
the placeholder text with ESRI Community Data, 2005. Click OK.
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Export the map layout document
The complete map is now ready to become exhibit 2 in your report. You will save it as a graphic file 
and insert it into the report template.

1 From the main menu bar, click File > Export Map to reach the Export Map dialog box. Navigate to 
your \GISMKT\OutdoorLivingFL folder. For File name, type CountyAd.emf, then click Save to save 
the map document as a graphic file in EMF format to include in your report.

2 In the project report template for this chapter, locate the page entitled Exhibit 2: County map for 
advertising campaign. Select the instructional text in brackets, then from the main menu bar in 
Microsoft Word, click Insert > Picture > From File. Navigate to your \GISMKT\OutdoorLivingFL 
folder and select the CountyAd.emf file. Click Insert to insert the picture into the report as exhibit 
2. (Note: You may have to select and resize the image to display it on the same page as the title.)

Exhibit 2 of your report is now complete.

Edit data frame contents in layout view
To produce exhibit 3 of your report, you must edit the contents of the map to display the ZIP Codes 
that will be the focus of Outdoor Living’s direct-mail campaign. To do so, you will edit the data 
frame and the map’s title and text.

1 In the ArcMap table of contents, click the check boxes to turn off the Number of Families in 
Target Market layer and turn on the Percent of Families in Target Market layer. Now this layer 
displays in the data frame area of layout view.

This is the layer you created in exercise 3.3 to identify the ZIP Codes to be included in the direct-
mail campaign. However, the selected ZIP Codes do not appear in the current map. To display 
them you must repeat the selection process you used in exercise 3.3.

2 Right-click the Percent of Families in Target Market layer, then click Open Attribute Table.

3 Click the Options button at the bottom of the attribute table, then choose Select by Attributes.

4 In the Select by Attributes dialog box, double-click the attribute name [PctFamInTM], then click 
the operator >=, then type .316 at the end of the equation in the Query box so that the full 
equation reads: [PctFamInTM] >= .316. (This is the minimum value of the highest quantile in the 
classification scheme.)
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5 Click Apply, then close the dialog box.

The selected ZIP Codes now appear in the layout. (Note: If this is not the case, press the F5 key to 
refresh the view.) You must now edit the title and text to reflect the new content of the map.
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6 Open the properties for the title at the top of the layout page.

7 Replace the existing title text with ZIP Codes Targeted for Outdoor Living’s Direct Mail Campaign. 
(Note: You may need to place a hard return after “Outdoor Living’s” so the type will fit neatly on 
the page.)

8 Click OK.

9 Open the properties for the large text box at the bottom of the page.

10 Delete the existing text and type: The ZIP Codes outlined in blue are those with the highest 
percentage of families in Outdoor Living’s target market. Selection of these ZIP Codes for 
the direct-mail campaign will maximize the number of target market families reached by the 
campaign. (Note: You may need to manually enter hard returns by pressing the Enter key at the 
end of each line for the text to fit neatly on the page.) Click OK.
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The resulting map now displays a title and explanatory text appropriate for the map’s contents. It is 
ready to be exported and inserted into the project report.
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Export the new layout document
1 From the main menu bar, click File > Export Map. Navigate to your \GISMKT\OutdoorLivingFL 

folder. For File Name, type ZIPMail.emf, then click Save to save the map document as a graphic 
file in EMF format to include in your report.

2 In the project report template, locate the page entitled Exhibit 3: ZIP Code map for direct mail 
campaign. Select the instructional text, and from the main menu bar in Microsoft Word, click 
Insert > Picture > From File. Navigate to your \GISMKT\OutdoorLivingFL folder and select the 
ZIPMail.emf file, then click Insert to insert the picture into the report as exhibit 3. (Note: You may 
have to select and resize the image to display it on the same page as the title.)

Exhibit 3 of your report is now complete.

Update report and save map document
1 Use these map documents and your conclusions from prior exercises to complete the following 

task. Summarize your answer in the appropriate section of the project report template.

Restate your recommendations briefly and explain how geographic targeting will increase 
the effectiveness of each of the three components of your local marketing campaign in 
Florida.

2 Save the map document as OutdoorLivingFL5_fl.mxd (replace f and l with your first and last 
initials) in your \GISMKT\OutdoorLivingFL folder.

3 Close ArcMap.

Your written report with both map document exhibits is complete and ready for submission.

Congratulations! You have completed the Outdoor Living project.

Pause for a moment to consider what you have accomplished in this chapter. You have learned about 
various types of demographic measures and observed their distribution in the state of Florida at 
different levels of geography. You have used this data to identify concentrations of target customers 
for each of the three components of Outdoor Living’s promotional campaign and designed map 
documents to communicate these results to an audience. In short, you have used ArcGIS as an 
effective analytical and communication tool in the market segmentation process.
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Additional applications

This project covers the most fundamental marketing strategy of identifying target customers and 
focusing marketing efforts on concentrations of those customers. Though this process can be 
implemented with the simplified data used here, it becomes even more powerful when applied with 
sophisticated data and targeting techniques.

For example, while this project uses simple demographics of families within a specific income 
range, ESRI Business Information Solutions (ESRI BIS)1 provides much more precise and complex 
analysis. Data is available on hundreds of additional variables, including ethnicity, income, 
household size and composition, housing ownership, housing value, net worth, type of employment, 
and educational attainment, among others. This data is available for a range of political, census, and 
postal geographies to support the needs of the analyst. In addition, several variables offer a range of 
historical values, current estimates, and future projections to support longitudinal study.

In addition to this wealth of demographic and socioeconomic data, ESRI BIS also offers extensive 
lifestyle data in the Community Tapestry Segmentation system. This system integrates demo-
graphic and socioeconomic information with lifestyle and purchasing data to provide profiles of 
65 distinct neighborhood clusters. This system provides marketers with a more detailed understand-
ing of the motivations, values, and lifestyles that underlie consumer purchasing patterns. Chapter 2 
provides an overview of this system and its marketing applications. Chapters 4 and 5 use this system 
to develop marketing strategies responsive to these lifestyle variations.

ESRI Business Analyst, a software and data extension to ArcGIS, combines this extensive data col-
lection with sophisticated analytical tools to support richer segmentation analysis. Working directly 
with customer files, an organization can create a profile of its best customers and then look across 
the United States for concentrations of prospective new customers who match that profile.

Several organizations use these capabilities to enhance their segmentation analysis. Galyans Sports 
and Outdoor stores, for example, uses its customer database integrated with demographic and  
Community Tapestry data from Business Analyst to focus its customer prospecting efforts.2 

Similarly, Telefónica del Perú has implemented a GIS system that supports a wide range of its opera-
tions, from facilities management to customer service.3 Among them is market analysis, in which 
thematic mapping is used to identify underserved areas of Peru, and attractive markets for wireless 
services among existing landline customers.

The Arizona Republic serves its advertisers by providing selective distribution of promotional materi-
als to households with desired demographic characteristics, thus improving response rates and  
advertising effectiveness.4 Advertisers can select ZIP Code level concentration or choose carrier 
routes within ZIP Codes to focus on target customers more closely. The Washington Times uses  
a similar approach to attract new subscribers. However, it focuses on lifestyle characteristics by  
targeting Community Tapestry segments in its marketing program.5

Western Exterminator also uses GIS tools to identify marketing opportunities in the metropoli-
tan areas it serves.6 The firm performs termite inspections that are required as part of home sales. 
By combining its internal records of inspections with home sales data by ZIP Code, the firm can 
identify ZIP Codes with high home sales and few inspections. These ZIP Code areas are growth 
opportunities for Western’s inspection services.
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As these examples illustrate, the business analysis capabilities that ArcGIS Desktop provides have 
tremendous value in the customer prospecting process. Identifying concentrations of target custom-
ers can improve the focus of promotional expenditures and help firms refine their products and hone 
their messages to find and serve their customers more effectively.

 1. ESRI Business Information Solutions is currently known as ESRI Community Data.
 2. Kevin Burgess, “Customer Analysis, Prospecting and Segmentation,” ESRI Business GeoInfo Summit,  
June 2004.
 3. Jim Baumann, “Are You Being Served,” Directions, May 19, 2005.
 4. Jay Visnansky, “Doing Market Focused Selling at the Arizona Republic,” ESRI Business GeoInfo 
Summit, April 2005.
 5. ESRI. “The Washington Times: GIS Increases Newspaper Subscriptions,” Business Analyst product 
promotion brochure, 2005.
 6. David Boyles, GIS Means Business:Vol. 2, Redlands, CA: ESRI Press, 2002.


